
 

 

 

BAB V 

SIMPULAN DAN SARAN 

5.1. Simpulan 

Berdasarkan penelitian yang telah dilaksanakan dapat disimpulkan bahwa : 

1. Berdasarkan hasil validasi ahli  dan praktisi maupun penguna produk dapat 

disimpulkan bahwa produk berupa modul praktikum bandul matematis 

berbasis spreadsheet pada microsoft excell 2007 yang telah dikembangkan 

telah layak untuk digunakan. 

2. Berdasarkan hasil validasi yang dilakukan oleh Penggunaan ahli  dan praktisi 

maupun penguna produk bahwa kualitas modul praktikum bandul matematis 

berbasis spreadsheet pada microsoft excell 2007 yang dikembangkan dapat 

digunakan dan karena telah memenuhi kelayakan pakai melalui uji coba 

menggunakan penyebaran angket. 

5.2. Saran  

Berdasarkan penelitian yang telah dilaksanakan dapat disimpulkan bahwa 

media pengembangan praktikum bandul matematis berbasis spreadsheet pada 

Microsoft excell 2007, maka diberikan beberapa saran bagi peneliti selanjutnya 

yaitu: 

1. Pengembangan modul praktikum bandul matematis berbasis spreadsheet pada 

Microsoft excell 2007 dapat digunakan dengan baik, namun masih memiliki 

kekurangan baik dari segi pendidkan, tampilan, dan kualitas teknis. Hal ini 

dapat dipertimbangan bagi penelitian selanjutnya untuk mengembangkan 

produk yang lebih sempurna lagi. 
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2.  Pengembangan modul praktikum bandul matematis berbasis spreadsheet pada 

Microsoft excell 2007 ini dapat dikembangkan lagi untuk beberapa materi 

fisika antara lain pegas. 
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Lampiran 1. 

ANALISIS DATA ANGKET VALIDASI PRODUK DAN MODUL AHLI 

MEDIA 

 

Validasi produk diperoleh dari data berupa skor ahli media melalui 

lembar validasi yang dijumlahkan kemudian total yang diperoleh 

dikonversikan menjadi data kualitatif. 

Interval Skor 

(M + 1,5s) < X A 

(M + 0,5s) < X ≤ (M + 1,50s) B 

(M - 0,50s) < X ≤ (M - 0,50s) C 

(M - 1,50s) < X ≤ (M - 1,50s) D 

X ≤ (M – 1,50s)  E 

1. Perhitungan untuk kriteria pendidikan  

a. Skor validasi produk penggunaan media dan modul 

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 9 = 45 

Skor minimal pernyataan x jumlah item soal = 1 x 9 = 9 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (45 + 9) 

 = 1/2 (54) 

 = 27 
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2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (45 – 9) 

 = 1/6/ (36) 

 = 6 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (27 + 1,50 x 6) < X 

 = (27 + 9) < X 

 = 36 < X 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (27 + 0,50 x 6) < X ≤ (27 + 1,50 x 6) 

  (27 + 3) < X ≤ (27 + 9) 

30 < X ≤ 36 

 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (27 - 0,50 x 6) < X ≤ (27 + 0,50 x 6) 

 (27 - 3) < X ≤ (27 + 3) 

  24 < X ≤ 30 
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d). (M - 1,50s) < X ≤ (M - 0,50s) 

(27 - 1,50 x 6) < X ≤ (27 - 0,50 x 6) 

(27 - 9) < X ≤ (27 - 3) 

18 < X ≤ 24 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (27 – 1,50 x 6) 

 X ≤ (27 – 9) 

 X ≤ 18  

Interval  skor 

(M + 1,5s) < X 36 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 30 < X ≤ 36 B 

(M - 0,50s) < X ≤ (M - 0,50s) 24 < X ≤ 30 C 

(M - 1,50s) < X ≤ (M - 1,50s) 18 < X ≤ 24 D 

X ≤ (M – 1,50s)  X ≤ 18 E 

 

Nama ahli media Nomer item kriteria pendidikan total skor 

Zulkarnain, M.Si 1 2 3 4 5 6 7 8 9 

5 5 5 5 5 5 5 5 5 45 A 
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2). Perhitungan untuk kriteria tampilan 

a. Skor validasi produk penggunaan media  

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 8 = 40 

Skor minimal pernyataan x jumlah item soal = 1 x 8 = 8 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (40 + 8) 

 = 1/2 (48) 

 = 24 

 

2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (40 – 8) 

 = 1/6/ (32) 

 = 5,33 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (24 + 1,50 x 5,33) < X 

 = (24 + 7,995) < X 

 = 31, 995 < X 
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b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (24 + 0,50 x 5,33) < X ≤ (24 + 1,50 x 5,33) 

  (24 + 2,665) < X ≤ (24 + 7,995) 

26, 665 < X ≤ 31,995 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (24 - 0,50 x 5,33) < X ≤ (24 + 0,50 x 5,33) 

 (24 – 2,665) < X ≤ (24 + 2,665) 

  21,665 < X ≤ 26,665 

 

d). (M - 1,50s) < X ≤ (M - 0,50s) 

(24 - 1,50 x 5,33) < X ≤ (24 - 0,50 x 5,33) 

(24 – 7,995) < X ≤ (24 – 2,665) 

16,005 < X ≤ 21,335 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (24 – 1,50 x 5,33) 

 X ≤ (27 – 7,995) 

 X ≤ 19.005 
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Interval  skor 

(M + 1,5s) < X 31, 995 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 26, 665 < X ≤ 31,995 B 

(M - 0,50s) < X ≤ (M - 0,50s) 21,665 < X ≤ 26,665 C 

(M - 1,50s) < X ≤ (M - 1,50s) 16,005 < X ≤ 21,335 D 

X ≤ (M – 1,50s)  X ≤ 19.005 E 

 

Nama ahli media Nomer item kriteria tampilan total skor 

Zulkarnain, M.Si 1 2 3 4 5 6 7 8 

5 5 5 5 5 5 5 5 40 A 

 

2). Perhitungan untuk kriteria teknis 

a. Skor validasi produk penggunaan media  

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 6 = 30 

Skor minimal pernyataan x jumlah item soal = 1 x 6 = 6 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (30 + 6) 

 = 1/2 (36) 

 = 18 
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2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 ( 30 – 6) 

 = 1/6 (4) 

 = 0,66 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (18 + 1,50 x 0,66) < X 

 = (18 + 0,99) < X 

 = 18,99 < X 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (18 + 0,50 x 0,66) < X ≤ (18 + 1,50 x 0,66) 

  (18 + 0,33) < X ≤ (18 + 0,99) 

18,33 < X ≤ 18,99 

 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (18 - 0,50 x 0,66) < X ≤ (18 + 0,50 x 0,66) 

 (18 – 0,33) < X ≤ (18 + 0,33) 

  17,67 < X 18,33 
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d). (M - 1,50s) < X ≤ (M - 0,50s) 

(18 - 1,50 x 0,66) < X ≤ (18 - 0,50 x 0,66) 

(18 – 0,99 ) < X ≤ (24 – 0,33) 

17, 01 < X ≤ 23,67 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (18 – 1,50 x 0,66) 

 X ≤ (18 – 0,99) 

 X ≤ 17,01 

 

Interval  skor 

(M + 1,5s) < X 18,99 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 18,33 < X ≤ 18,99 B 

(M - 0,50s) < X ≤ (M - 0,50s) 17,67 < X ≤18,33 C 

(M - 1,50s) < X ≤ (M - 1,50s) 17, 01 < X ≤ 23,67 D 

X ≤ (M – 1,50s)  X ≤ 17,01 E 

 

 

 

 

   

 

 

Nama ahli media Nomer item kriteria 

pendidikan 

total Skor 

Zulkarnain, M.Si 1 2 3 4 5 6 

5 4 5 5 5 5 29 A 
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Lampiran 2. 

ANALISIS DATA ANGKET VALIDASI PRODUK DAN MODUL AHLI 

MATERI 

Validasi produk diperoleh dari data berupa skor ahli materi melalui lembar 

validasi yang dijumlahkan kemudian total yang diperoleh dikonversikan menjadi 

data kualitatif. 

Interval Skor 

(M + 1,5s) < X A 

(M + 0,5s) < X ≤ (M + 1,50s) B 

(M - 0,50s) < X ≤ (M - 0,50s) C 

(M - 1,50s) < X ≤ (M - 1,50s) D 

X ≤ (M – 1,50s)  E 

 

1. Perhitungan untuk kriteria pendidikan  

a. Skor validasi produk penggunaan media dan modul  

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 9 = 45 

Skor minimal pernyataan x jumlah item soal = 1 x 9 = 9 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (45 + 9) 

 = 1/2 (54) 

 = 27 
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2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (45 – 9) 

 = 1/6/ (36) 

 = 6 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (27 + 1,50 x 6) < X 

 = (27 + 9) < X 

 = 36 < X 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (27 + 0,50 x 6) < X ≤ (27 + 1,50 x 6) 

  (27 + 3) < X ≤ (27 + 9) 

30 < X ≤ 36 

 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (27 - 0,50 x 6) < X ≤ (27 + 0,50 x 6) 

 (27 - 3) < X ≤ (27 + 3) 

  24 < X ≤ 30 

d). (M - 1,50s) < X ≤ (M - 0,50s) 
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(27 - 1,50 x 6) < X ≤ (27 - 0,50 x 6) 

(27 - 9) < X ≤ (27 - 3) 

18 < X ≤ 24 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (27 – 1,50 x 6) 

 X ≤ (27 – 9) 

 X ≤ 18  

 

Interval  skor 

(M + 1,5s) < X 36 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 30 < X ≤ 36 B 

(M - 0,50s) < X ≤ (M - 0,50s) 24 < X ≤ 30 C 

(M - 1,50s) < X ≤ (M - 1,50s) 18 < X ≤ 24 D 

X ≤ (M – 1,50s)  X ≤ 18 E 

 

 

Nama ahli media Nomer item kriteria pendidikan total skor 

Islahudin, M.Pfis 1 2 3 4 5 6 7 8 9 

4 4 5 4 4 4 4 5 4 38 A 
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Lampiran 3. 

ANALISIS DATA ANGKET VALIDASI PRODUK DAN MODUL AHLI 

PRAKTISI 

Validasi produk diperoleh dari data berupa skor ahli media melalui lembar 

validasi yang dijumlahkan kemudian total yang diperoleh dikonversikan menjadi 

data kualitatif. 

Interval Skor 

(M + 1,5s) < X A 

(M + 0,5s) < X ≤ (M + 1,50s) B 

(M - 0,50s) < X ≤ (M - 0,50s) C 

(M - 1,50s) < X ≤ (M - 1,50s) D 

X ≤ (M – 1,50s)  E 

 

1. Perhitungan untuk kriteria pendidikan  

a. Skor validasi produk penggunaan media dan modul 

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 9 = 45 

Skor minimal pernyataan x jumlah item soal = 1 x 9 = 9 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (45 + 9) 

 = 1/2 (54) 

 = 27 
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2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (45 – 9) 

 = 1/6/ (36) 

 = 6 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (27 + 1,50 x 6) < X 

 = (27 + 9) < X 

 = 36 < X 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (27 + 0,50 x 6) < X ≤ (27 + 1,50 x 6) 

  (27 + 3) < X ≤ (27 + 9) 

30 < X ≤ 36 

 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (27 - 0,50 x 6) < X ≤ (27 + 0,50 x 6) 

 (27 - 3) < X ≤ (27 + 3) 

  24 < X ≤ 30 
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d). (M - 1,50s) < X ≤ (M - 0,50s) 

(27 - 1,50 x 6) < X ≤ (27 - 0,50 x 6) 

(27 - 9) < X ≤ (27 - 3) 

18 < X ≤ 24 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (27 – 1,50 x 6) 

 X ≤ (27 – 9) 

 X ≤ 18  

Interval  skor 

(M + 1,5s) < X 36 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 30 < X ≤ 36 B 

(M - 0,50s) < X ≤ (M - 0,50s) 24 < X ≤ 30 C 

(M - 1,50s) < X ≤ (M - 1,50s) 18 < X ≤ 24 D 

X ≤ (M – 1,50s)  X ≤ 18 E 

  

Nama ahli media Nomer item kriteria pendidikan total skor 

M. Isnaini, M.Pd 1 2 3 4 5 6 7 8 9 

5 4 3 3 3 3 5 5 4 35 B 
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2). Perhitungan untuk kriteria tampilan 

a. Skor validasi produk penggunaan media  

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 8 = 40 

Skor minimal pernyataan x jumlah item soal = 1 x 8 = 8 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (40 + 8) 

 = 1/2 (48) 

 = 24 

 

2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (40 – 8) 

 = 1/6/ (32) 

 = 5,33 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (24 + 1,50 x 5,33) < X 

 = (24 + 7,995) < X 

 = 31, 995 < X 
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b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (24 + 0,50 x 5,33) < X ≤ (24 + 1,50 x 5,33) 

  (24 + 2,665) < X ≤ (24 + 7,995) 

26, 665 < X ≤ 31,995 

 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (24 - 0,50 x 5,33) < X ≤ (24 + 0,50 x 5,33) 

 (24 – 2,665) < X ≤ (24 + 2,665) 

  21,665 < X ≤ 26,665 

 

d). (M - 1,50s) < X ≤ (M - 0,50s) 

(24 - 1,50 x 5,33) < X ≤ (24 - 0,50 x 5,33) 

(24 – 7,995) < X ≤ (24 – 2,665) 

16,005 < X ≤ 21,335 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (24 – 1,50 x 5,33) 

 X ≤ (27 – 7,995) 

 X ≤ 19.005 
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Interval  Skor 

(M + 1,5s) < X 31, 995 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 26, 665 < X ≤ 31,995 B 

(M - 0,50s) < X ≤ (M - 0,50s) 21,665 < X ≤ 26,665 C 

(M - 1,50s) < X ≤ (M - 1,50s) 16,005 < X ≤ 21,335 D 

X ≤ (M – 1,50s)  X ≤ 19.005 E 

 

Nama ahli media Nomer item kriteria tampilan total Skor 

M. Isnaini, M.Pd 1 2 3 4 5 6 7 8 

5 5 4 4 4 3 5 5 35 B 

 

2). Perhitungan untuk kriteria teknis 

a. Skor validasi produk penggunaan media  

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 5 x 6 = 30 

Skor minimal pernyataan x jumlah item soal = 1 x 6 = 6 

 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (30 + 6) 

 = 1/2 (36) 

 = 18 
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2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 ( 30 – 6) 

 = 1/6 (4) 

 = 0,66 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (18 + 1,50 x 0,66) < X 

 = (18 + 0,99) < X 

 = 18,99 < X 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (18 + 0,50 x 0,66) < X ≤ (18 + 1,50 x 0,66) 

  (18 + 0,33) < X ≤ (18 + 0,99) 

18,33 < X ≤ 18,99 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (18 - 0,50 x 0,66) < X ≤ (18 + 0,50 x 0,66) 

 (18 – 0,33) < X ≤ (18 + 0,33) 

  17,67 < X 18,33 

 

d). (M - 1,50s) < X ≤ (M - 0,50s) 

(18 - 1,50 x 0,66) < X ≤ (18 - 0,50 x 0,66) 

50 



 

 

(18 – 0,99 ) < X ≤ (24 – 0,33) 

17, 01 < X ≤ 23,67 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (18 – 1,50 x 0,66) 

 X ≤ (18 – 0,99) 

 X ≤ 17,01 

 

Interval  Skor 

(M + 1,5s) < X 18,99 < X A 

(M + 0,5s) < X ≤ (M + 1,50s) 18,33 < X ≤ 18,99 B 

(M - 0,50s) < X ≤ (M - 0,50s) 17,67 < X ≤18,33 C 

(M - 1,50s) < X ≤ (M - 1,50s) 17, 01 < X ≤ 23,67 D 

X ≤ (M – 1,50s)  X ≤ 17,01 E 

 

 

 

 

 

 

 

 

 

Nama ahli media Nomer item kualitas 

teknis 

total Skor 

M. Isnaini, M.Pd 1 2 3 4 5 6 

5 4 5 3 4 5 26 A 
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Lampiran 4. 

ANALISIS DATA ANGKET VALIDASI PRODUK DAN MODUL PEMAKAI 

MEDIA 

Validasi produk diperoleh dari data berupa skor oleh pemakai media 

melalui lembar validasi yang dijumlahkan kemudian total yang diperoleh 

dikonversikan menjadi data kualitatif. 

Interval Skor 

(M + 1,5s) < X A 

(M + 0,5s) < X ≤ (M + 1,50s) B 

(M - 0,50s) < X ≤ (M - 0,50s) C 

(M - 1,50s) < X ≤ (M - 1,50s) D 

X ≤ (M – 1,50s)  E 

 

1. Perhitungan untuk validasi media dan modul oleh pemakai media dalam skala 

besar 

a. Skor validasi produk penggunaan media dan modul 

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 4 x 11 = 44 

Skor minimal pernyataan x jumlah item soal = 1 x 11 = 11 
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M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (44 + 11) 

 = 1/2 (55) 

 = 27,5 

 

2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (44 – 11) 

 = 1/6/ (33) 

 = 5,5 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (27,5 + 1,50 x 5,5) < X 

 = (27,5 + 8,25) < X 

 = 36 < X < 35,75 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (27,5 + 0,50 x 5,5) < X ≤ (27,5 + 1,50 x 5,5) 

  (27,5 + 2,75) < X ≤ (27,5 + 8,25) 

30,25 < X ≤ 35,75 
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c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (27,5 - 0,50 x 5,5) < X ≤ (27,5 + 0,50 x 5,5) 

 (27,5 – 2,75) < X ≤ (27,5 + 2,75) 

  24,75 < X ≤ 30,25 

 

d). (M - 1,50s) < X ≤ (M - 0,50s) 

(27,5 - 1,50 x 5,5) < X ≤ (27,5 - 0,50 x 5,5) 

(27,5 – 8,35) < X ≤ (27.5 – 2,75) 

19,15 < X ≤ 24,75 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (27,5 – 1,50 x 5,5) 

 X ≤ (27,5 – 8,25) 

 X ≤ 19,25 

 

Interval  Skor 

(M + 1,5s) < X 36 < X < 35,75 A 

(M + 0,5s) < X ≤ (M + 1,50s) 30,25 < X ≤ 35,75 B 

(M - 0,50s) < X ≤ (M - 0,50s)  24,75 < X ≤ 30,25 C 

(M - 1,50s) < X ≤ (M - 1,50s) 19,15 < X ≤ 24,75 D 

X ≤ (M – 1,50s)  X ≤ 19,25 E 
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Nama  Nomer Item Angket Validasi Total   Skor 

1 2 3 4 5 6 7 8 9 10 11 

Prama Ardana 4 4 4 4 3 4 3 4 3 2 3 38 A 

Juriatin 3 3 3 3 4 4 3 4 3 4 4 38 A 

Agil Triadin 4 4 4 4 3 3 4 3 3 3 4 39 A 

Rosdaniah 4 3 4 4 3 4 3 3 4 3 3 38 A 

Junardin  4 4 3 4 3 3 3 4 3 4 3 38 A 

Ferniawam 3 3 4 4 3 3 3 4 4 3 4 38 A 

Nurkomariah  4 3 3 4 3 4 4 3 4 2 4 38 A 

Alfiati  4 3 4 3 3 3 4 3 4 3 3 37 A 

 

2. Perhitungan untuk validasi media dan modul oleh pemakai media dalam skala 

kecil 

a. Skor validasi produk penggunaan media dan modul 

1). Menentukan skor rerata ideal  

Skor maksimal pernyataan x jumlah item soal = 4 x 11 = 44 

Skor minimal pernyataan x jumlah item soal = 1 x 11 = 11 

M = Rerata skor ideal 

 = 1/2 (skor maksimal ideal + skor minimal ideal) 

 = 1/2 (44 + 11) 

 = 1/2 (55) 

 = 27,5 
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2). Simpangan baku ideal 

S = Simpangan baku ideal 

 = 1/6 (skor maksimal ideal – skor minimal ideal) 

 = 1/6 (44 – 11) 

 = 1/6/ (33) 

 = 5,5 

 

3).  Perhitungan data interval  

a).  (M + 1,50s) < X 

  (M + 1,50s) = (27,5 + 1,50 x 5,5) < X 

 = (27,5 + 8,25) < X 

 = 36 < X < 35,75 

 

b).  (M + 0,50s) < X ≤ (M + 1,50s) 

  (27,5 + 0,50 x 5,5) < X ≤ (27,5 + 1,50 x 5,5) 

  (27,5 + 2,75) < X ≤ (27,5 + 8,25) 

30,25 < X ≤ 35,75 

 

c).  (M - 0,50s) < X ≤ (M + 0,50s) 

 (27,5 - 0,50 x 5,5) < X ≤ (27,5 + 0,50 x 5,5) 

 (27,5 – 2,75) < X ≤ (27,5 + 2,75) 

  24,75 < X ≤ 30,25 
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d). (M - 1,50s) < X ≤ (M - 0,50s) 

(27,5 - 1,50 x 5,5) < X ≤ (27,5 - 0,50 x 5,5) 

(27,5 – 8,35) < X ≤ (27.5 – 2,75) 

19,15 < X ≤ 24,75 

 

e).  X ≤ (M – 1,50s) 

 X ≤ (27,5 – 1,50 x 5,5) 

 X ≤ (27,5 – 8,25) 

 X ≤ 19,25 

 

 

 

 

 

Interval  Skor 

(M + 1,5s) < X 36 < X < 35,75 A 

(M + 0,5s) < X ≤ (M + 1,50s) 30,25 < X ≤ 35,75 B 

(M - 0,50s) < X ≤ (M - 0,50s)  24,75 < X ≤ 30,25 C 

(M - 1,50s) < X ≤ (M - 1,50s) 19,15 < X ≤ 24,75 D 

X ≤ (M – 1,50s)  X ≤ 19,25 E 
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Nama Pemakai Dan 

Modul 

Nomer Item Angket Validasi Total  Skor 

1 2 3 4 5 6 7 8 9 10 11 

Nurisnalalita 3 3 3 4 4 3 4 4 3 3 3 37 A 

Kemal Idris 4 4 3 4 3 3 4 4 3 4 4 40 A 

Junardin  4 4 3 4 3 3 3 4 3 4 3 38 A 

Tarmizi  3 4 3 4 4 4 3 3 3 3 3 37 A 
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Lampiran 5. Surat Izin Penelitian 
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Lampiran 6. Foto – Foto Kegiatan Penelitian 

1. Kelompok kecil 

 

 

 

 

 

 

     (dokumentasi tanggal 2 Agustus 2019 pada semester 8) 

 

 

 

 

 

 

 

(dokumentasi tanggal 3 Agustus 2019 pada semester 4) 
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(dokumentasi tanggal 2 Agustus 2019 pada semester 2) 

 

2. Kelompok Besar 

 

 

 

 

 

 

 

(dokumentasi tanggal 30 Juli 2019 pada Satu kelas semester 8) 
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(dokumentasi tanggal 30 Juli 2019 pada Satu kelas semester 8) 
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Lampiran 7. Lembar Konsultasi 
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Lampiran 8. Modul praktikum 

 

MODUL PRAKTIKUM BANDUL MATEMATIS 

BERBASIS SPREADSHEET PADA MICROSOFT 

EXCELL 2007 
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PRAKATA 

 

Assalamu'alaikum warohmatulloohiwabarokaatuh 

Segala puji kami panjatkan kehadirst Allah Subhanahuwata'ala, karena atas 

segala rahmat dan karunia-Nya modul yang berjudul "Modul Praktikum 

Bandul Matematis Berbasis Spreadsheet Pada Microsoft Excell 2007" ini 

bisa terealisasikan dengan baik. Semoga buku ini modul ini bisa dijadikan salah 

satu bahan refrensi dalam praktikum bagi dosen atau guru fisika, mahasiswa, 

serta guru dalam melaksanakan praktikum terkait dengan materi bandul 

matematis. 

Modul ini terdiri dari 3 BAB, yaitu BAB I Bandul Matematis, BAB II 

Spreadsheet Microsoft Excell 2007, BAB III Prosedur Pembuatan Simulasi 

Bandul Matematis. 

Ucapan terimaksih penulis sampaikan kepada semua pihak yang telah 

membantu dalam penyusunan buku ini. Kami menyadari bahwa modul ini masih 

jauh dari kata sempurna dan banyak kekurangannya, sehingga kritik dan saran 

dari berbagai pihak yang sifatnya membangun demi kesempurnaan modul ini 

kedepan sangat kami harapkan. 

Wassalamu'alaikum warohmatulloohiwabarokaatuh  

 

 

 

 

 

 

 

Mataram, 7Juli 2019 
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MODUL PRAKTIKUM BANDUL MATEMATIS 

BERBASIS SPREADSHEET PADA MICROSOFT 

EXCELL 2007 

 

Tujuan  : cara merancang simulasi praktikum bandul matematis berbasis spreadsheet 

pada microsoft excell 2007 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

BAB I BANDUL MATEMATIS 

 

1.1.Gerak  Bandul 

Gerak bandul merupakan gerak harmonik sederhana hanya jika amplitudo 

geraknya kecil. gambar 2.1 memeperlihatkan bandul sederhana yang terdiri 

dari tali dengan panjang L dan beban bermassa m. Gaya yang bekerja pada 

beban adalah beratnya mg dan tegangan T pada tali. Bila tali membuat sudut Ф 

terhadap vertikal, berat memiliki komponen – komponen mg cos Ф sepanjang 

tali dan mg  sin Ф tegak lurus tali dalam arah berkurannya Ф. Misalkan s 

sebagai panjang busur diukur dari dasar lingkaran. Panjang busur dihubungkan 

ke sudut Ф oleh : 

   Ф 

Komponen tangensial tangensial percepatan benda adalah d²s/dt². Komponen 

tangensial hukum kedua newton adalah : 

∑            Ф  (   )   
   

   
 

Atau  

   

   
      Ф          

 

 
 

 

Jika s jauh lebih kecil dari pada s/L, sudut Ф = s/L adalah kecil, dan kita dapat 

mendekati sin Ф dengan sudut Ф. Dengan menggunakan sin (s/L) ≈ s/L dalam 

persamaan 2.2, kita akan memperoleh : 

(Tipler. 1998) 

2.1 

2,2 

2.3 



 

 

 

  Ф  

 

  Ф 

  

   

   
  

 

 
  

Kita dapat melihat bahwa untuk sudut cukup kecil sehingga sin Ф ≈ Ф berlaku, 

percepatan berbanding lurus dengan simpangannya. Gerak bandul dengan 

demikian mendekati gerak harmonik sederhana untuk simpangan kecil. Persamaan 

2.4 dapat ditulis sebagai berikut  

   

   
      

Dengan  

  
 

 
 

Penyelesaian persamaan 2.5 adalah s = sₒ cos (ωt + δ), dengan sₒ adalah 

simpangan maksimum diukur sepanjang busur lingkaran. Priode gerak harmonik 

tersebut adalah  

  
  

 
   

√ 

√ 
 

 

Menurut persamaan 12-32 makin panjang tali, makin besar periode, yang 

konsisten dengan pengamatan eksperimen. Perhatikan bahwa periode tidak 

T 

L 

mg 

mg cos Ф s 

mg sin Ф 

2.4 

2.5 

2.6 

2.7 

(Tipler.1998) 

Gambar 2.1. gerak bandul 



 

 

bergantung massa. Hal ini berlaku karena gaya pemulih berbanding lurus dengan 

massa. Karena itu, percepatan a = F/m karena itu tak bergantung pada massa. 

Perhatikan bahwa frekuensi dan periode tak bergantung pada amplitudo osilasi, 

segi umum gerak harmonik sederhana. Seringkali gerak bandul sederhana lebih 

mudah dinyatakan dalam bentuk simpangan sudut Ф. Dengan menggunaka s = 

L/Ф dalam persamaan 2.3, kita akan memperoleh  

  ( Ф)

   
        Ф 

 

Atau 

  ( Ф)

   
  

 

 
   Ф 

Yang untuk Ф kecil menjadi  

  ( Ф)

   
  

 

 
    Ф 

 

Penyelesaian persamaan 2.10 adalah 

Ф  Фₒ    (    ) 

Dengan Фₒ = sₒ /L sebagai simpangan sudut maksimum. Kriteria gerak harmonik 

sederhana yang dinyatakan dlam besaran – besaran sudut ini adalah bahwa 

percepatan sudut harus berbanding lurus dengan simpangan sudut dan berlawanan 

arah seperti dalam persamaan 2.10. 

(Tipler.1998) 

 

 

 

2.8 

2.9 

2.10 

2.11 



 

 

BAB II  

SPREADSHEET PADA MICROSOSOFT EXCELL 

2.1. Spreadsheet Microsoft Excell 

Microsoft Excel adalah suatu aplikasi berbasis spreadsheet yang 

dikembangkan oleh Microsoft Corporation untuk Windows, Mac OS X, Android 

and iOS. Pada umumnya, Microsoft Excel tidak lebih dari sebuah kalkulator atau 

sebuah worksheet yang dapat melakukan perhitungan, hal-hal yang berhubungan 

dengan grafik, ataupun pemrograman makro. Selain itu, Microsoft Excel juga 

kebanyakan hanya diketahui sebagai pengolah kata sederhana dengan tabel yang 

telah built-in. 

 
Tidak banyak orang yang mengetahui mengenai fitur pemrograman makro 

ini yang memungkinkan user memanipulasi dan mengoptimalkan program 

dibandingkan fitur standar spreadsheet. User dapat membuat program sendiri 

secara langsung dengan menggunakan VisualBasic Editor (VBE) yang meliputi 

fitur menulis, debugging, dan membuat berbagai fungsi (dalam VBA akan disebut 

module). User dapat menerapkan metode numerik dan mengoptimalkan berbagai 

kerjaan seperti organisasi data, dan memandu perhitungan di VBA. 
 

Untuk menggunakan fitur VBA Excel, diperlukan menu developer. Adapun 

cara untuk menampilkan menu developer adalah:  
3. Microsoft Excel 2007  

Dari menu utama, masuk ke Excel options > pada tab Populat, centang 

Show Developer tab in the Ribbon 

 

 

 

 

 

 

 

 

 

 



 

 

 

 
 
 
 
 
 

Gambar 2.1. Menampilkan Ribbon Developer pada Ms. Office 2007 

 

4. Microsoft Excel 2010 ke atas  
Pilih menu File > Options > Customize Ribbon > pilih Developer. 

 

 

 

 

 

Gambar 2.2. Menampilkan Ribbon Developer  

pada Ms. Office 2010 ke atas 

 

Macro Reader 

Fitur ini berfungsi untuk merekam setiap aktivitas yang dilakukan 

pada worksheet. Macros akan menyimpan keadaan worksheet tepat 

sebelum Stop Recording dipilih. 

 

 

 

 

Gambar 2.3 Tampilan menu Macros 

 

Record Macro dapat diaktifkan ketika proses membuat tabel atau 

mengisi data apapun, kemudian ingin mengetahui bagaimana code VBA 

(Visual Basic for Application) yang dibentuk. Agar lebih memahami, coba 

langkah-langkah berikut: 



 

 

1. Aktifkan Record Macro pada ribbon developer saat worksheet 

masih kosong. Beri keterangan pada Macro name, contoh:Macro1 

(tidak boleh ada spasi dan karakter khusus). Shortcut key dan 

Description bersifat optional. 

 

 

 

 
 
 
 
 

 

Gambar 2.4 Tampilan Record Makro 

 

2. Tuliskan nama Anda pada sel yang aktif. Pada gambar di atas, 

misalkan sel A1. 
 

3. Pindahkan sel aktif ke sel dibawahnya (pada kasus diatas, 

dimisalkan A2). Ketikan formula berikut: 
 

4. Pilih formula sel tersebut dan tekan Ctrl+C untuk copy sel ke 

clipboard. 
 

5. Paste nilainya sebagai values (V) untuk mengonversi formula ke 

nilainya. 
 

6. Pilih sel aktif dan sel di atasnya yang tadi telah ditulis nama. Dalam 

kasus ini sel A1 dan A2.  
7. Ubah format menjadi Bold dan ukuran font 18 pt. 

 
8. Pilih ribbon Developer, klik Stop Recording. 

 
9. Untuk melihat code macro yang telah dibuat, klik Visual Basic di 

ribbon Developer untuk membuka Visual basic Editor. 

 

Menulis “Hello World!” Dalam Kotak Pesan 

Pada latihan ini, dengan mengeklik suatu tombol, akan muncul 

kotak pesan yang bertuliskan “Hello World!”. Adapun langkahnya adalah 

:  
4. Pada ribbon developer, pilih Insert, di bagian ActiveXControl, dan 

masukkan item Button ke dalam sheet excel. 

 

 

 



 

 

 

 

 

 

Gambar 2.5. Insert tombol 
 

2.  Letakkanpada sheet excel dengan click and drag untuk 

mengatur ukuran tombol. 

 

 
 
 
 
 

 

 

 

Gambar 2.6. Command Button 
 

     Untuk mengubah tulisan CommandButton1, harus dipastikan menu 

Design Mode di ribbon developer aktif. Kemudian klik kanan > 

CommandButton Object > Edit.  

3. Double-click button tersebut, sampai muncul jendela program, 

ketikan program berikut untuk menampilkan kotak pesan. 

 
 
 
 
 
 
 
 

 

 

 

 

 

Gambar 2. 7. Tampilan Visual Basic Editor atau Excel VBA 

Integrated Development Environment (IDE) 
 



 

 

6. Jalankan program dengan menekan tombol play (lihat bulat 

merah di gambar di atas)  
7. Hasil akhir yang diharapkan minimal sebagai berikut : 

 

 

 

 

Gambar 2.8. Hello World pada kotak pesan 

 

Insert Nilai Melalui Kotak Pesan Yang Dibuat Dengan Fungsi 

 
Selain untuk menampilkan pesan, Kotak Pesan juga dapat 

digunakan untuk memasukkan suatu nilai yang nantinya dapat diolah lebih 

lanjut untuk ditampilkan pada sheet excel. Pada latihan ini, diperkenalkan 

suatu fungsi yang nantinya akan dipanggil ketika mengeklik tombol. 

Adapun langkahnya sebagai berikut. 
 

4. Pada ribbon Developer, klik Visual Basic untuk menampilkan Visual 

Basic Editor atau Excel VBA Integrated Development Environment 

(IDE)  
5. Pilih Insert > Module  
6. Ketikan program berikut. 

 

 
 

 
 
 
 
 

 
Gambar 2.9. Program fungsi module 

 



 

 

6. Buat tombol baru kemudian ubah tulisan “CommandButton1” 

menjadi “Masukkan Nilai”. (Lihat petunjuk pada subteori 

sebelumnya)  
7. Double-click button tersebut, sampai muncul jendela program, 

ketikan program berikutuntuk menampilkan kotak pesan. 
 
  
 
 
 

 

 

 

Gambar 2.10. Memasukkan fungsi module yang telah 

dibuat pada command button 

 
8. Sehingga tampilan akan seperti berikut: 

 
 
 
 
 
 
 

 

 

 

Gambar 2.11. Latihan Mandiri dengan Input Nilai 

melalui Box 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

BAB III  

TATA CARA PEMBUATAN SIMULASI PRAKTIKUM BANDUL 

MATEMATIS BERBASIS SPREADSHEET PADA MICROSOFT EXCELL 

 

1. Buka lembar kerja (worksheet) Ms. Excel 

 

Gambar 3.1. Lembar kerja Excel 

 

2. Ketik beberapa nama/simbol komponen yang berlaku pada sistem 

bandul ayunan, seperti gambar di bawah ini. 

 

 

 

 

 

 

 

Cell (A3) 

dst. 

Cell (A5) 



 

 

 

 

 

Tabel 3.2. Sel-sel yang dibutuhkan 

Ketik nama 

besaran 

Sel (B) dibiarkan kosong terlebih dahulu, dan 

beberapa sel diisi dengan formula tertentu. 

Ketik  

satuannya 

Sudut awal = 

(pada sel A3) 

 (
o
) 

(pada sel C3) 

Panjang tali = 

(pada sel A4)   

 (cm) 

(pada sel C4) 

Sudut = 

(pada sel A5) 

tulis persamaan  

=B3*COS((2*PI()/K2*Sheet1!$K$1)) 

(pada Sel B5) 

(
o
) 

(pada sel C5) 

Massa = 

(pada sel A6) 

 (gr) 

(pada sel C6) 

Periode (T) =  

(pada sel A10) 

tulis persamaan  

=2*PI()*SQRT(B4/9.8)  

(pada Sel K2) 

(detik) 

(pada sel C10) 

(Variabel) t 

(pada sel A13) 

(Variabel) x 

(pada sel B13) 

(Variabel) y 

(pada sel C13) 

Waktu: 

(pada sel J1) 

 (detik) 

(pada sel L1) 

 

3. Membuat Jendela display grafik/kurva dan pilihan data yang 

beroperasi. 

a. Letakan kursor pada salah cells yang kosong  Klik menu 

insert, → pilih X-Y scatters, (muncul “layar displaygrafik” 

pada worksheet).  

 



 

 

 

 

 

 

b. Klik kanan pada “layar display” → pilih “Select data” 

 

 

Gambar 3.3.  Jendela select data dan X-Y scatters. 

 

c. Klik “add”, muncul kotak dialog add series 

 

 

 

 

 

Gambar 3.4. Jendela Microsoft Visual basic. 

 

Series Name 

Series X-values 

Series Y-values 

X-Y scatter Select Data 

Box :Select Data 

X-Y scatter 

“layar 

displaygrafik” 

Add 



 

 

Untuk data panjang tali: 

- Ketik “Panjang tali” pada Series name,  

- select range data untuk sumbu x pada kotak series X-

value, dan  

- select range data untuk sumbu y pada kotak series Y-

value. 

 

 

-  

 

- Ok. 

 

d. Klik “add” lagi, 

Untuk data Bola bandul : 

- Ketik “Bandul/Bola” pada Series name, 

- select range data (arahkan/geret kursor pada data yang 

dipilih) untuk sumbu x pada kotak series X-value, dan  

- select range data (arahkan/geret kursor pada data yang 

dipilih) untuk sumbu y pada kotak series Y-value. 

 

 

 

 

 

- Ok. 

 

e. Klik “add” lagi, 

Untuk simulasi gerak bandul, dst.  



 

 

- Ketik “Simulasi” pada Series name,  

- select data range (arahkan/geret kursor pada data yang 

dipilih) untuk nilai sumbu x pada kotak series X-value, 

dan  

- select range data untuk sumbu y pada kotak series Y-

value. (Data rangenya berbeda dengan yang 

sebelumnya). 

 

 

 

 

 

- Ok. 

Setelah semua unsur label data di atas dilakukan, maka akan muncul 

dialog box Select data source seperti dalam gambar di bawah ini, (Jika ingin 

mengubah dapat dilakukan melalui klik fungsi Edit). 

 

 

 

 

 

 

 

Gambar 3.4 jendela select data source 

 

f. Klik “Ok”, makapada layar display grafik akan terlihat titik-

titik koordinat data sebagai berikut. 

Gerak Bandul 

Panjang Tali 

Simulasi 

Edit 



 

 

 

 

4. Mengatur skala Jendela display grafik/kurva. 

a. Untuk mensetting (mengatur) skala sumbu x:  

- Klik lokasi angka skala pada sumbu x, dan klik kanan pada 

sumbu tersebut  pilih “Format Axis”. 

 

 

Gambar 3.5. Format axis 

 

- Padakotak dialog Format Axis pilih Axis 

Optioncentangfixed untuk mengatur nilai maksimum dan 

minimum sumbu x yang dikehendaki pada display grafik, 

 lalu klik Close. (dalam contoh latihan ini angka-angka di 

atur seperti yang tertlihat dalam gambar di bawah). 

 

Format Axis 



 

 

 

Gambar 3.6. Jendela format axis-x. 

 

b. Hal sama dilakukan untuk mengatur sumbu y.  

(Sehingga dalam contoh ini angka-angka tertlihat 

dalam gambar di bawah). 

 

 

Gambar 3.7. Jendela format axis-y 

 

5. Membuat tombol-tombol eksekusi program melalui fungsi 

Developer. 

a. Klik toolbar Developer,  kemudian klik Insert (Pilih model 

button pada Active X control)  dalam contoh ini pilih 

CommandButton. 

 

Format Axis 

Fixed 



 

 

 

Gambar 3.8. Toolbar insert dan active control. 

b. Membentuk tombol dengan menggeret mouse pada lokasi 

tertentu dan sesuai dengan ukuran yang dikehedaki ke layar 

worksheet excel.  

Untuk tombol pertama akan tampil dengan nama 

“CommandButton1”. 

 

 

 

 

 

 

 

Gambar 3.9. tombol Commandbutton1. 

 

c. Dengan tahap yang sama, membentuk lagi tombol 

“CommandButton2” dan CommandButton3 (Ingat, jangan 

mencopy-paste!). 

 

Tombol: CommandButton 

Insert 
Developer 

 ActiveX Control 

CommandButton1 



 

 

 

Gambar 3.10. Commandbutton2 dan commandbutton3 

 

d. Untuk mengganti nama masing-masing tombol 

“CommandButton” dilakukan dengan cara:   

Klik kanan pada tombol CommandButton1/2/3 pilih 

Properties, sorot Caption lalu menulis nama pengganti yang 

Sesuai tujuan fungsi tombol. 

 

 

Gambar 3.11.Jendela properties. 

Pada contoh latihan ini nama tombol diganti menjadi: 

- CommandButton1 menjadi Setting,  

- CommandButton2 menjadi Mulai,  

- CommandButton3 menjadi Berhenti. 

CommandButton2 

CommandButton3 

Properties 

Caption 



 

 

 

Gambar 3.12. Merubah Nama commandbutton. 

 

Catatan: Dalam menu Properties dapat dieksplorasi lebih jauh untuk 

mengatur “Jenis huruf, Size huruf & tombol, warna huruf dan beckground 

tombol, dan lain sebagainya, (Silahkan dieksplorasi sendiri untuk 

memahaminya!). 

 

Jika tombol-tombol ini ingin diatur setelah worksheet tersimpan namun tidak 

berfungsi, maka ubah status macro security nya pada keadaan Diasable all 

Macros Except lalu klik/aktifkan menu visual Basic dan mulai 

mengeksplorasi tombol. 

 

6. Membuat Coding pada masing-masing tombol 

CommandButtonuntuk mengeksekusi program yang dibangun, 

dengan cara sebagai berikut: 

a. Double klik CommandButton1/2/3 pada worksheet excel.  

kemudian akan muncul jendela “Microsoft Visual Basic” di 

bawah ini. 

 

 

 

 



 

 

 

 

 

 

 

 

Gambar 3.13. Layar kerja coding Microsoft Visual Basic. 

 

b. Menulis code program dalam masing-masing 

CommandButton1/2/3 sesuai dengan fungsi dan sistem yang 

akan bekerja. 

 

 

Gambar 3.14. Coding Sistem Ayunan matematis sederhana 



 

 

Adapun cara penggunaan untuk membuka praktikum bandul matematis 

berbasis spreadsheet pada Microsoft excel 2007 : 

1. Membuka dan mengklik 2 kali pada aplikasi Microsoft Excell yang telah 

dbuat simulasi praktikumnya pada layar monitor   

2. lalu pilih dan klik "option" 

 

 

 

 

 

 

 

 

 

3.  setelah menekan option, kemudian pilih "Enable This Conten" dan pilih "ok" 

 

 

 

 

 



 

 

 

4. setelah itu anda dapat mengoperasikan program yang sudah di buat didalam 

microsoft excell dengan mengubah nilai pada panjang tali maupun sudut awal 

sesuai dengan kebutuhan  

 

 

 

 

 

 

Menjalankan Applikasi Animasi yang telah dibangun, dilakukan dengan langkah-

langkah berikut: 

a. Mengisi sels B3 untuk nilai sudut awal, misalnya = 60 (
o
). 

b. Mengisi sels B4 untuk nilai panjang tali, misalnya = 40 (cm). 

c. Mengisi sels B6 untuk nilai massa bandul, misalnya = 100 (gr). 

d. Klik tombol mulai/Start untuk menjalankan aplikasi (bentuk simulasi 

bandul akan terlihat seperti pada gambar di atas). 

e. Klik tombol berhenti/Stop untuk menghentikan simulasi yang sedang 

berjalan. 

f. Klik tombol setting/Reset untuk pengaturan ulang (kembali ke awal). 

g. Masukan nilai sudut awal pada sel B3 dan panjang tali pada sel B4 yang 

berbeda-beda, kemudian lihat pergerakan bandulnya dan nilai periode dari 

gerak bandul tersebut.  

 

 

 



 

 

 

DAFTAR PUSTAKA 

Ariani, Niken. Dkk. 2001. Pembuatan Multimedia Di Sekolah. Prestasi Pustaka : 

Jakarta 

Hamalik, Oemar. 2000. Metode Pembelajaran.Jakarta : Erlangga 

http://www.vbtutor.net/VBA/vba_chp2.htm tutorial VBA EXCEL di akses 17 mei 2019 

Madcoms. 2008. Microsoft Excel 2007 Pemograman VBA. Andi Publisher : 

Yogyakarta 

Microsoft Product (URL : https://products.office.com/id-ID/?legRedir=default& 

CorrelationId =c859a10c -1708-46c0-aad8-d61331e3916a diakses 

tanggal 17 Mei 2019 pukul 19.23) 

Paul A. Tipler.1997. Fisika Untuk Sains Dan Teknik Edisi Ketiga (terjemahan). 

Jakarta : Erlangga 

 Resnick, Haliday. Fisika Jilid 1 Edisi Diperluas. Jakarta: Erlangga 

 

Suprapto, B. http://ijp.fi.itb.ac.id/index.php/ijp/article/viewFile/161/162 Kontribusi 

Fisika Indonesia Vol. 13 No.2, April 2002 

 

Teukolsky, Saul A. et al. (2007). Numerical recipes: the art of scientific computing 

(3rd ed.). Cambridge University Press. 

VBA 2010 Video Tutorial (URL :http://www.yourprogrammingnetwork.co.uk/vba-

2010/ diakses pada tanggal 11 Mei 2019 pukul 13.33) 

 

Walkenbach, John. (2013). Excel VBA Programming For Dummies (3rd ed.). John 

Wiley & Sons. 

 

 



 

 

GLOSARIUM 

 

Bandul  : Benda yang terikat pada sebuah tali dan dapat berayun 

secara bebas dan periodik yang menjadi dasar kerja 

dari sebuah jam diding kuno yang mempunyai 

ayunan 

Coding    : Code program dalam microsoft excell 

Command button : Tombol yang digunakan sebagai pemicu untuk 

menjalankan sebuah event, misalnya menjumlahkan, 

menerjemahkan, memasukkan, menghapus input dan 

lain lain 

Develover tab : Tab pengembang excell 

Format Axis : Mengubah format nomor pada sumbu nilai 

Kursor : Suatu petunjuk posisi pada monitor komputer atau 

piranti tampilan lain yang akan merespon masukkan 

dari suatu masukan teks atau piranti teks 

Layar Display : Tampilan buku kerja pada komputer 

Microsoft excell : Pengolah angka yang menggunakan spreadsheet yang 

terdiri dari baris dan kolom untuk mengeksekusi 

perintah  

Osilasi  : Variasi periodik terhadap waktu  dari hasil pengukuran 

Percepatan Gravitasi : Suatu objek yang berada pada permukaan laut dikatakan 

ekuivalen dengan 1 g, yang didefinisikan memiliki 

nilai 9,8 m/s² 

Periode : Waktu yang diperlukan untuk melakukan satu kali 

getaran 

Properties : Mengganti nama – nama tombol pada setiap tombol 

command button 

Ribbon  : Kumpulan perintah yang terdiri dari beberapa tab menu, 

yang mana setiap tab terdiri dari tombol – tombol 



 

 

perintah dalam grupp tertentu 

Simulasi : Suatu proses peniruan dari sesuatu yang nyata beserta 

keadaan sekelilingnya 

Spreadsheet   Lembaran kertas yang menunjukan akuntansi atau data 

lain dalam baris dan kolom 

Toolbar : Tombol navigasi yabg merupakan bagian dari desain 

antar muka (GUI) suatu aplikasi  

Visual Basic excell : Sebuah fungsi yang ditanamkan kedalam microsoft 

excell 

Worksheet : Halaman kerja sheet pada microsoft excell 

 

 


